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LANGUAGE DECLARATION OF CONFORMITY
Spanish Mediante el presente documento, Benefon declara que este teléfono móvil, del tipo TGP79EB, satisface los requisitos 

esenciales y todas las demás disposiciones pertinentes de la Directiva 1999/5/EC.

Danish Benefon Oyj erklærer herved, at denne mobiltelefon af typen TGP79EB er i overensstemmelse med de væsentlige 

krav og andre relevante betemmelser i Directive 1999/5/EC.

German Hiermit erklärt Benefon Oyj, daß dieses Mobiltelefon vom Typ TGP79EB die wesentlichen Anforderungen und andere 

relevante Bestimmungen der Richtlinie 1999/5/EC erfüllt.

Greek Με το παρόν, η Benefon Oyj δηλώνει ότι αυτό το κινητό τηλέφωνο, τύπου TGP79EB, συµµορφώνεται µε τις ουσιώδεις 
απαιτήσεις και άλλους σχετικούς όρους της Οδηγίας 1999/5/EC.

English Hereby, Benefon Oyj declares that this mobile phone, type TGP79EB, is in compliance with the essential 

requirements and other relevant provisions of Directive 1999/5/EC.

French Benefon Oyj déclare par les présentes que ce téléphone mobile, de type TGP79EB, est conforme aux exigences 

essentielles et aux dispositions correspondantes de la Directive européenne 1999/5/EC.

Italian Benefon Oyj dichiara che questo modello di telefono cellulare, tipo TGP79EB, risponde alle principali specifiche e 

misure previste dalla Direttiva 1999/5/EC.

Dutch Bij deze verklaart Benefon Oyj dat deze mobiele telefoon, type TGP79EB, voldoet aan de voornaamste eisen en 

andere relevante voorwaarden van Richtlijn 1999/5/EC.

Portuguese A Benefon Oyj declara pela presente que este telemóvel, do tipo TGP79EB, está em conformidade com os requisitos 

essenciais e outras disposições relevantes da Directiva 1999/5/EC.

Finnish Benefon Oyj vakuuttaa, että tämä matkapuhelin, tyyppiä TGP79EB, on direktiivin 1999/5/EC olennaisten vaatimusten 

ja muiden asianomaisten määräysten mukainen

Swedish Härmed förklarar Benefon Oyj att denna mobiltelefon, typ TGP79EB, överenstämmer med de grundläggande kraven 

och andra relevanta bestämmelser i Direktiv 1999/5/EC.

Information in this manual is subject to change without notice. BENEFON
reserves the right to change or improve their products and to make
changes in the content without obligation to notify any person or
organization of such changes or improvements. BENEFON is not
responsible for any loss of data, income or any consequential damage
whatsoever caused.   

Manufacturer: Benefon Oyj, P.O. Box 84, 

24101 Salo, Finland 

Web site: www.benefon.com
0168
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PART A: GENERALTRACKKEEPER NT 2.0 OPERATING INSTRUCTIONS
PART A: GENERAL

MECHANICS AND ENVIRONMENTAL 
EFFECTS

Sight
The device must have an unobstructed view to satellites at

any time. 

In marginal conditions, e.g. when staying in surroundings

with heavy tree cover or in a shadow area in between base

stations, an external GPS antenna, possibly even a GSM an-

tenna, must be installed. 

The device can be used like a standard GSM phone though

for two-way voice connection an optional headset (ZE5520)

must be used. In some cases, the device can be built in

clothes or special vests.

If the device is mounted somehow, it must be attached to

the surface so that the back of the device is facing up. To en-

sure proper functioning of the GPS, GPS antenna can be cov-

ered with plastic, fiber glass or clothes, but not with metal. 

Temperature ranges
•Usage: -20 to +55 C°  with a standard Li-Ion battery 

•Charging: Standard Li-Ion battery must not be charged

below 0°. Likewise, charging above +45 C° is prevented. 

At temperatures below -25°C, or above +60 C°, the battery

will not supply power and the device cannot be used. 

Upon warming up/cooling down, the device will function

properly again.  

Mechanical durability 
The device is dust and splash proof. The protection category

for the device is IPX4. 

To meet these requirements, the rubber seal must be insert-

ed in place correctly. 
MECHANICS AND ENVIRONMENTAL EFFECTS 7



PART A: GENERAL
 

1. Place the rubber seal so
that it lies at the bottom
of the battery hole (1). 

2. Fit the rubber tab into
the recess in the upper
left corner (2). 

3. Lift the cap on the top of
the rubber tab (3).

4. Fit the battery in place. 

5. Push the battery into the
device until it locks in
place, and make sure
the release catch has
clicked into place. 

6. The idea is that the bat-
tery will be securely fas-
tened in the battery
hole.   

7. Stuff the bottom cover
into the system connec-
tor so that the cover will
be firmly secured
around the connector
(4). 

REMOVING THE BATTERY:
Push the release catch
downwards and pull the bat-
tery carefully away from the
device.

CAP RUBBER TAB

1

BOTTOM COVER

SYSTEM CONNECTOR

INSERTING THE BATTERY AND RUBBER SEAL

4

3

2

1. Slide the SIM card holder
to the right. Lift the holder
into an upright position. 

2. Insert the card into the
holder. Check that the cut
corner is at the lower left
side of the holder. 

3. Close the holder by pus-
hing it towards the devi-
ce. Slide the holder back
to the left until it locks.

1

2

3

INSERTING THE SIM CARD
8 MECHANICS AND ENVIRONMENTAL EFFECTS



PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
PART B: CONFIGURING 
SETTINGS FOR THE 

TRACKKEEPER
There are two ways to configure settings for the TrackKeep-

er: 

You can use the MPTP commands, and transfer settings re-

motely, over the air by sending a protocol message to the

phone. The MPTP commands can be sent as a command

string or through a specific software, such as the Benefon In

Charge.    

•You can use AT commands for configuring settings and

transfer them to the phone locally, via the BW data/NMEA

cable. This can be easily done by using the Benefon Con-

figurator software.  

MPTP MESSAGES AND 
REMOTE CONFIGURATION (OTA)

MPTP configuration commands are used when a remote up-

date of device configuration is needed. Update can include

all telematics settings and phone numbers, such as emer-

gency numbers, authorized numbers, GPS operating mode. 

For the remote configuration, the settings must be coded as

as MPTP messages. 

 THE BENEFON CONFIGURATOR 
SOFTWARE FOR TRACKKEEPER  

The Benefon Configurator software is intended for editing

settings locally for the device. Since the Benefon Configura-

tor is very easy to use, it is advisable to make initial and oth-

er major configurations for the device with this software. 

When you are finished with editing, you can either transfer

the settings back to the device via the cable immediately, or

save them in a computer disk (as any normal file) for further

use. 

The settings done within the software can be transferred to

the device via the Data cable or NMEA 0183 cable (in the lat-

ter case, use the Data adapter for the connection). 

Another, slightly quicker way to transfer configurations

made by Benefon Configurator is to use the SetupLoad soft-

ware. For more information on it, please contact your deal-

er. 

The application window is split in two sections: 

•The Benetree structure is located on the left. It consists of

two main nodes: My benefon (on-line) and My computer
(off-line). By clicking the main nodes, you can access their

sub-nodes. By clicking the sub-node, you can access the

corresponding Benefon Configurator document files. 

•The Document window is located on the right. The setting

groups are divided up into interleaves containing separate

data fields. 
For more information on MPTP messages, see the document on MPTP
commands, located at the Web site: www.benefon.com.
MPTP MESSAGES AND REMOTE CONFIGURATION (OTA) 9



PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
Connecting the TrackKeeper 
to the Benefon Configurator   

1. Plug the square-end of the Data cable into a serial port

of your computer. The NMEA 0183 cable contains two

square-end adapters. In case you use the NMEA 0183 ca-

ble, plug the data adapter (1) into a serial port. Serial

ports are located at the back panel of your computer. 

Next plug the small end (2) of the cable into the system

connector on the bottom of the device. 

   

2. Open the Benefon Configurator. 

3. Choose the correct serial port from the toolbar:  Click

the pop-up menu and highlight the desired port.

  

Or, choose Benefon Configurator... from the Edit menu.

Select the Default communication port by clicking the
check box. Click OK to exit the menu. 

     

4. Double-click the main node My Benefon. Or, double-
click the TrackKeeper icon. Or, choose Connect from the

Mobile menu. Or, click the button Connect located on
the toolbar. 

  

5. The software establishes a connection to the device and

renames My Benefon node according to the type of the
device, in this case TrackKeeper.

6. At the same time the software reads data from the device

and loads it in the display. The data contains currently

existing settings and menus from the device. In Benetree

1

2

THE MAIN IDEA IS THAT THE PORT SELECTED IN SOFTWARE

MATCHES WITH THE PORT THE DATA ADAPTER IS PLUGGED IN.
10 THE BENEFON CONFIGURATOR SOFTWARE FOR TRACKKEEPER



PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
these settings and menus are shown as sub-nodes, such

as User settings, and Telematics settings under the main

node My Benefon. 

7. If the software requests security code while loading the

settings, you must key in the code and press Ok. For
more information on security code, see SECURITY CODE

ON PAGE 42.  

8. Click the name label TrackKeeper. The sub-nodes will be
displayed as icons in the Document window on the

right. 

9. You can choose the desired sub-node/icon by clicking it.

The data fields will be displayed. 

Loading settings from the TrackKeeper
to the software

As you connect the device to the software, all current set-

tings in the device are copied to the software. 

To load only part of the settings to the software, choose

Benefon Configurator... from the Edit menu. Check the de-

sired setting groups, which are located in the Mobile phone
start up tasks. Click Ok while the dialog box is displayed. 

Unloaded settings can be loaded later on in the same ses-

sion by choosing Open NNsettings from the Mobile menu.  

Saving settings in a computer disk
1. If the device is not currently connected to the software,

you can still make configurations, save them and trans-

fer them to the device afterwards.  When working this

way, data fields are available for editing via My computer
node.    

2. To save data in a computer disk, choose Save as... from
the File menu. You can also click the function icon on

the toolbar. 

3. Select the destination drive and folder, and rename the

file the way you like. Click Save. The software stores all
data fields that the chosen node (e.g. User settings) con-
tains. 

TIP: 
IT IS ADVISABLE TO ALWAYS SAVE THE SETTINGS IN THE COMPUTER
DISK. THIS WAY, THE READY-MADE SETTINGS CAN BE EASILY RECALLED
AND CHECKED AT ANY TIME NEEDED, EVEN WHEN THE DEVICE IS FAR
AWAY. 
WHEN THE SETTINGS ARE STORED IN THE COMPUTER AS A NORMAL
FILE, COPYING THEM TO OTHER SIMILAR DEVICES, OR MAKING
CHANGES TO THEM SHOULD BE QUITE EASY.   
THE BENEFON CONFIGURATOR SOFTWARE FOR TRACKKEEPER 11



PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
Transferring settings from the
software to the Trackkeeper

While the Benefon Configurator is connected to the device,

you can save data in the device.  

1. First open the Benefon Configurator document which

content you want to save in the device. 

Settings which are previously stored in a computer disk

can be recalled by choosing Open from the File menu, 

or pressing the corresponding function icon on the tool-

bar.   

2. Choose Save To Mobile from the File menu. 

Or, click the function icon on the toolbar.  

When transferring data to the device, the previous data

is replaced with the new data.   

Changing default mobile phone
When any Benefon phone or device is connected to the

Benefon Configurator, the software identifies it automatical-

ly, and offers you correct data fields for editing.  

To make off-line configuration for some other Benefon

phone (e.g. Esc!) when the phone is currently unavailable,

you need to change the default mobile phone in Benefon

Configurator. 

1. Change the default Benefon mobile phone by selecting

Benefon Configurator... from the Edit menu, or highlight-

ing the desired device or phone model from the pop-up

menu, located  on the toolbar.

2. Now the data fields of this "new" phone model are avail-

able and can be opened from My computer node on the
left. 

3. Click the desired node, e.g. User settings, press the
mouse´s right button and select New >Ok.  

4. Similarily, you can close the file which is not needed any

more by clicking it, pressing the mouse´s right button

and selecting Close. 
12 THE BENEFON CONFIGURATOR SOFTWARE FOR TRACKKEEPER



PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
Disconnecting the TrackKeeper 
from the software   

1. Choose Disconnect from the Mobile menu. 

Or, click the button Disconnect on the toolbar.
     

2. To unplug the device from the cable, press the release

button (3) on the top of the small end of the cable. 

Gently pull the cable from the system connector of the

device.

 

ACTIVATING NEW FEATURES
Some of the new features are sold separately, they are not

included in the basic software NT 2.0 package. Such features

are, e.g. Waypoint tracking, CSD trace download, Encryp-

tion, Vertical sensor and Update of an old software into the

new NT 2.0 software. 

When you purchase these new features, a Service activation
key is provided to you by the dealer or the manufacturer.

The key is needed for activating the features. Activation can

be easily done with the Benefon Configurator. 

1. First make sure, the device has cable connection to the

Benefon Configurator. 

2. Click Connect.   

3. Select Save activation key from the Mobile menu. 

4. Key in the Service activation key. (Note that when updat-
ing the software, the device may inform you of the incor-

rect software version. You have then 2 minutes to key in

the activation key until the device will power off itself.)     

5. Click Save. 

6. Click Disconnect. 

3

ACTIVATING NEW FEATURES 13



PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
SIM FEATURES: SHORT MESSAGES
In order to read, write, send and receive normal short mes-

sages via the device, the device must be connected to an ex-

ternal device. 

The external device attached to the device can be e.g. a com-

puter, a laptop or a palm computer. Since the device lacks

the keyboard and screen, the external device must be pro-

vided with these. The physical connection is established

with the data cable. 

A suitable software, for example the Benefon Configurator,

is needed for the communication as well.

Reading and editing existing 
messages

You can read and edit messages you have written and saved

as .sms files in the computer. 

To open messages stored in the computer, select Open from
the File menu. Make sure the Files of type shows Short mes-
sages (or All Benefon Configurator Files). Find the desired
file by browsing and click Open. 

Messages are listed and can be read. 

Editing: Double-click the message you want to edit. Edit text

and other details and click Ok when ready.  

Writing and sending a short message  
1. Open the Benefon Configurator.  

2. Double-click the icons SIM, Short messages and Own
messages. 

3. Choose Sms, New message from the Edit menu.

4. Key in the message text and the recipient´s number. By

clicking the square beside the topic, the number can be

fetched from the Phone book, assuming the number is

found.   

5. Make sure, the Sms service number is correct. It can be
changed by clicking the square beside. By selecting the

option SIM card default, the SMS service number will be

picked up from the SIM card. If the SIM card does not

contain the SMS number, select the option Own and key
in the SMS number. 

6. Select the desired Saving/Sending action by checking the
box. 

7. Complete by pressing Ok. 

NOTE: When the device is disconnected, you can still write

short messages and save them for further use, but sending

the message is possible only while the device is connected

to the software. To work in off-line, you need to select Short
messages from My computer node. 
14 SIM FEATURES: SHORT MESSAGES



PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
SIM FEATURES: PHONE BOOK
As you open the Phone book, the memory entries stored in

the SIM card are listed and can be processed. Index number

stands for memory slot number.  

Editing and adding an entry
1. To edit details of an entry, click the desired entry. To

add a new phone book entry, click a blank line (1).

2. Key in name and number (2). 

3. By pressing Tab on the keyboard you can move from a

data field to another.

Deleting entries  
1. To delete a phone book entry, click the desired entry. 

2. Press Delete on the keyboard. You can also choose the
command Delete from the Edit  menu, or by clicking the

mouse´s right button. 

Moving and copying entries   
1. To move or copy a phone book entry to another slot,

click the desired entry. 

2. Press Ctrl+C (for copy) or Ctrl+X (for cut) on the key-

board. Click the destination line and press Ctrl+V (for

paste) on the keyboard. 

You can also choose the commands Copy, Cut and Paste
from the Edit menu, or by clicking the mouse´s right

button. 

Or, you can click the corresponding function icons on

the toolbar.  

  

3. If the destination line is reserved, you also need to con-

firm, whether to overwrite the old information or not. 

 - To overwrite the old information, click Yes while the
Dialog box is displayed. 

 - To preserve the old information and transfer the new

information to another free slot (Index number), click

No while the Dialog box is displayed.  

Copy Cut Paste
SIM FEATURES: PHONE BOOK 15



PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
Arranging entries
Arrange the phone book by Index, Name, or Number either by

 - clicking the title

 - choosing the option from the Edit menu 

 - clicking the mouse´s right button.

•Sort by: Rearranges the phone book permanently. When

transferring the phone book data back to the device, the

data will be arranged by the new order. 

•View by: Rearranges the phone book temporarily. When

transferring the phone book data back to the device, the

data will be arranged by the old order.

USER SETTINGS

Phone time and date   

Time and date can be set in the Benefon Configurator. 

Key in the time and date in the GMT format (“Greenwich

Time”). Date and time can be selected by clicking the ar-

rows, as well.  

Time stamps associating MPTP messages are displayed in the

GMT format, as well. 

The device will also adjust its date and time in first position

fix from GPS. 
16 USER SETTINGS



PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
Activity timer   

The device can be configured to update its position, e.g.

once a day and report it to the service center.  

Activity timer can also be used to wake up the device peri-

odically to check if there are any incoming messages. If

there are no messages, it will return to sleep for the next

wake-up. 

The timer consists of three data fields: 

1. Start time. Click the arrows or key in the date and time,

when the timer is switched on for the first time.  

2. Interval. Key in the interval for wake-up.  

3. Positioning skip. It may not be necessary to determine

the current position each time when the timer is turned

on. By setting a value N for the position skip, the device

can be programmed to only determine the position ev-

ery Nth time the timer is turned on.

Message settings 

SMS SERVICE NUMBER

You can store the SMS service number (1), which is needed
for sending normal short messages and telematics protocol

messages. 

Most SIM cards have the SMS number already stored. Thus

setting the number in most cases is not necessary. 

However, when the number is separately stored in the de-

vice´s own memory, it will speeden up initiation of the de-

vice, especially SMS processes.   

The number must be set correctly, otherwise sending short

messages is not possible. The SMS service number can be

found e.g. in the manual of your local network operator. 

3

2

1

3

2

1
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
However, if you are supplied with a separate SMS service

number for telematics protocol messages, you may store the

number in the Protocol settings data field, found in the
Telematic settings. 

Configuring separate SMS service number for protocol mes-

sages is recommended in case the Activity timer is used. 

MESSAGE TYPE 

You can determine what kind of a message you are process-

ing. You can choose the message type from these: Text, Fax,
X400, Email, Ermes, or Data. 

When using the device for normal or MPTP messaging, click

the arrow and highlight Text for message type (2). 

MESSAGE VALIDITY

You can select the length of validity for normal SMS messag-

es, i.e. for how long the SMS messages are stored in the serv-

er of the operator.

You can choose the message validity from these: 1 hour, 6
hours, 24 hours, 1 week or Maximum time. 

Click the arrow and highlight the desired option (3).

The length of validity for telematics protocol messages is se-

lected in General telematic settings. For more information,

see MESSAGE VALIDITY ON PAGE 30. 

Port and audio settings 

AUTOMATIC ANSWER 

The automatic answer function can be turned on or off. 

•If the Automatic answer is turned on (1), a voice call to the
device from any number is possible. 

•If the Automatic answer is turned off (the check box is left
blank), making a voice call to the device can only be done

from a number listed as an allowed caller. Allowed callers

are stored in the General telematics settings. For more

information, see LIST OF ALLOWED CALLERS ON PAGE 29.

3

2

1

4
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
The device contains a built-in microphone. By making a call

to the device, the caller (e.g. service center) can listen in the

device and its surroundings. After certain number of rings,

the device answers an incoming call automatically by open-

ing audio connection. 

To have audio both ways, the automatic answer must be

turned on and the device must either  

 - contain a built-in speaker, or 

 - be connected to the Headset. 

DATA PORT ACTIVITY

This setting defines, whether the data port is turned on or

off (2). 

Data port setting must be turned on in case the device is

needed for data transfer and connected to some external de-

vice. 

If the port is not needed, it is recommended to turn the data

port off for decreasing the power consumption. 

•To turn the data port on, check the box. 

•To turn the data port off, leave the box blank.     

AUDIO 

• Internal: The device contains an internal microphone and

uses it. 

•External: Audio comes from some external device, e.g.

Headset,  via the configuration port. 

Click the arrow and highlight the desired option (3). 

VISIBLE MODE

The device can be set to operate 

•In visible mode (the box is checked) or 

•In invisible mode (the box is left blank). 

In Visible mode the LEDs are lit as described in this manual

(see INDICATOR LEDS ON PAGE 43). 

Invisible mode is for making the device more difficult to de-

tect. In invisible mode only some of basic LED patterns are

lit, e.g. when entering incorrect pin or powering up/down.

This way e.g. sending emergency messages can be done very

discreetly.  

This configuration can be done both ways: locally in the

Benefon Configurator, and remotely via MPTP messaging. 
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
Settings during battery loading 

GPS OPERATING MODE

You can select, which one of the GPS power modes is on

while the device is being charged (1). 

Set the GPS Off in case  

•the time reserved for charging is quite short

•GPS functions are not needed during charging process.  

By selecting No change, the GPS mode remains in the previ-

ously configured mode.  

GSM ACTIVATION 

You can select, whether the GSM is turned on or off while

the device is being charged.

In case the GSM functions are needed even during the

charging, this setting (2) must be turned on (box checked). 

PORTABLE

This setting defines efficiency of charging. 

When using the TrackKeeper mainly as portable device,

check the box (3). This way battery will be charged com-

pletely and kept full of charge while the device is connected

to a charger.    

If the device is most of the time connected to a charger, the

check box should be left blank in order to maximise the life

of the battery. 
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
GPS settings SETTING GPS OPERATING MODE

The GPS receiver in the device uses power saving options

for ensuring maximum battery capacity. Click the arrow and

highlight the desired option (1). The GPS receiver has three

modes:

•Full power without the power saving option. 

•Off 

•Economy  

Operating mode depends on the way, the device is used. Au-

tonomous system, i.e. a portable device, normally uses

Economy mode, while device with constant power supply,

i.e. a fixed device,  uses Full Power mode.

NMEA OUTPUT

The NMEA port output can be turned on or off (2).  This de-

vice supports a subset of NMEA 0183 v2.0 output protocol,

which is used for transferring position data between the de-

vice and a navigation system, such as a Search and Rescue

application. For the connection you also need a separate

NMEA cable, which is sold as an accessory.  

•By selecting Off, you will turn the NMEA output port off. 

•By selecting a transferring speed you will turn the NMEA

output on.    

When the NMEA output is turned on, the device will con-
sume slightly more power. 
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
ASSISTED GPS (AGPS)

The device has capability to receive assistance to the GPS re-

ceiver in order to speed up the initial position calculation.

This is very useful feature if the device is in poor satellite

coverage. 

Assistance can be supplied over the Mobile Phone Telemat-

ics Protocol in a binary coded protocol message. The mes-

sage will contain ephemeric and almanac data which is

based on a rough position calculated by e.g. GSM network

parameters (Cell-ID, CI-TA etc). The assisted GPS is supplied

from a third party station server.  

Using the AGPS does not affect the accuracy of the position.

If  the last position fix is deemed to be too old, and the AGPS

is set, the AGPS feature is automatically used to speed up the

position determination.  

The cost of  the AGPS service is determined on the contract

of the service provider. 

You can specify settings for ordering assisted GPS informa-

tion from a service provider (3). 

•Number of satellites: Select the number of satellites. 

However, please note that the more satellites selected, the

faster the service but the higher the charge.  

•SMS number: Key in the SMS number of the AGPS service.   

SLEEPING TIME (IN ECONOMY MODE)

As a default setting, the GPS economy mode calculates posi-

tion approximately every 45 seconds. The position interval

consists of two things:

•An ideal sleeping time for the GPS plus 

•An actual time needed for searching satellites and calcu-

lating position by the GPS. 

The sleeping time is adjustable (4). In the Benefon Configu-

rator, key in the sleeping time in seconds. The sleeping time

should be rounded to tens, otherwise the software does the

rounding.

E.g. by entering 27, the ideal sleeping time will be rounded

to 30 seconds. Note that 20 seconds is the minimum value. 

NOTE: The time needed for searching and calculating satel-

lites depends on present circumstances, e.g. satellite cover-

age, age of the latest position fix, distance from the previous

to the current position and so on.  
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
GPS TUNING

You can set tuning values for the GPS receiver. Depending

on selected value, the GPS prioritizes precision over quick-

ness or vice versa. 

Set the value by clicking the arrow and highlighting the de-

sired option (5). 

•Quick: The GPS is tuned for quick position fix. The
receiver can acquire position fix quite fast in moderate or

good conditions. Position can be acquired even in a bad

satellite coverage, but the accuracy might not be so good. 

•Precise: The GPS is tuned for high accuracy. However,
acquiring position fix might take time and can be prob-

lematic in a bad satellite coverage. 
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TELEMATIC SETTINGS

Tracking settings 
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
TRACKING

Tracking (1) is remotely controlled by the service center.

When the tracking function is turned on, the position infor-

mation is sent to the service center several times in se-

quence. 

Essential phone numbers, such as Service center number and
SMS service number must be configured in the device. In the

Benefon Configurator, these numbers can be set in the Gen-
eral telematic settings.    

If the device is temporarily switched off, battery is removed,

or the power supply is some other way disconnected, the

tracking record (e.g. amount of messages) will be reset and

start from the beginning. 

D u r a t i o n

You can select, for how long or on what terms tracking will

be on. After that, the tracking will be turned off automatical-

ly. Only one of these options can be turned on at once.

•Continuous: The tracking will be turned on until further
notice. !Deactivation message must be sent separately. 

•Amount of sent messages: Tracking will be on until
defined amount of messages has been sent to the service

center. Key in the amount and confirm your choice.   

•Duration: Tracking will be on for a period of time. Key in

how many days, hours and minutes, the tracking should

be on.     

•End time: Tracking will be on until the end time is

reached. Key in the date and time, the tracking should be

turned off. Date and time can be selected by clicking the

arrows, as well.  

I n t e r v a l

The given interval, e.g. 60 minutes, indicates that the device

will send its position to the service center at intervals of 60

minutes. 

Key in the tracking interval in minutes. 

A c t i v a t i o n

Make sure all the required settings for tracking are complet-

ed before activating the function. Such settings are, e.g. du-

ration and interval. New settings can be applied only while

the tracking is deactivated. 

In this device model tracking is always activated or deacti-

vated by sending an MPTP message to the device from the

service center.   
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
AREA TRACKING 

Area tracking (2) is remotely controlled by the service center

(or some other authorized number). When the area tracking

is turned on, the position information will be sent to the ser-

vice center only when the device is moving in or out of the

pre-defined area.  

Essential phone numbers, such as Service center number and
SMS service number must be configured in the device. In the

Benefon Configurator, these numbers can be set in the Gen-
eral telematic settings.    

The area can be determined by keying in a center point and

a radius of an area. The area tracking does not contain the

duration option, i.e. the area tracking will never be turned

off automatically. 

I n t e r v a l

The given interval, e.g. 60 minutes, indicates that the device

will send its position to the service center at intervals of 60

minutes, but only in case the device is located outside of the

determined area. 

Key in the interval for area tracking in minutes.   

C e n t e r  p o i n t

Key in the center point name (e.g. Home) and enter coordi-

nates.   

R a d i u s

Key in the desired radius in 10 meters. E.g. by entering 20,

your actual radius will be 200 meters.  

A l a r m  m o d e

You can set an alarm to alert when crossing the borderline

of an area. The alarm can be set to alert either when arriving

in or departing from the particular area. 

Click the arrow and highlight the desired option.

A c t i v a t i o n

Make sure that all the required settings for area tracking are

completed before activating the function. Such settings are,

e.g. interval, center point, radius and alarm mode (at arrival

or departure). New settings can be applied only while the

area tracking is deactivated. 

In this device model area tracking is always activated or de-

activated by sending an MPTP message to the device from

the service center.   
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
DEFAULT BEHAVIOUR FOR LOCATION 
REQUEST 

The device may receive several different messages request-

ing location. Such messages can be, e.g. Location request

messages (?LOC), or Location history request messages

(?HIS). (For more information on how to create location re-

quest messages, see the separate MPTP document.) 

You can define, which way the device responds the location

requests (3). 

The message always includes a time stamp indicating age of

the position. 

Choose from the options below by checking the corre-

sponding box in the Benefon Configurator. 

•Send last known position: When the device receives the

location request, the device immediately recalls the latest

position found in the memory and sends it to the request-

ing number. The position can be quite old. If the device

does not have a position at all, the message will be sent

without position. 

•Attempt to acquire a fresh position for a while: When the

device receives the location request, the device immedi-

ately switches the GPS on (if it is currently off), updates

position, sends it and switches the GPS off. Then the

device returns to normal idle mode. Only in case the posi-

tion update is NOT possible within 3 - 4 minutes, the

device will send the latest position found in the memory

to the requesting number.

•Send last known position at once: When the device receives

the location request, the device immediately recalls the

latest position found in the memory and sends it to the

requesting number. In addition to that, the device tries to

update the position for 3 - 4 minutes. If the position

update succeeds, the new position is sent to the request-

ing number, as well.     
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
General telematic settings 
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
SERVICE CENTER NUMBER

You can change and store the phone number, which is used

for sending  telematics protocol messages to the service cen-

ter. 

Key in the number of the service center (1).

LIST OF ALLOWED CALLERS

You can view, edit and store several numbers for allowed

callers (2). You can also attach the automatic answer func-

tion to the desired numbers. 

Allowed callers are the ones, who are permitted to call to

the device at any time: Calls from these specific numbers are

always put through. 

In fact, if the Automatic answer check box in the User settings
is left blank, allowed callers are the only ones whose calls

are put through. For more information, see AUTOMATIC AN-

SWER ON PAGE 18.  

PROTOCOL SETTINGS

A u t h o r i z a t i o n

The device is allowed to respond to protocol messages sent

from the authorized numbers automatically at any time. Al-

ways authorized numbers are: 

•The numbers stored as Authorized numbers   

•The numbers stored as Emergency center numbers 

•The number stored as the Service center number.   

Authorization on - the setting is Enabled (3)

 - If authorization is turned on, all requests coming from

authorized numbers are automatically processed. Any

responses are sent to the number from which the re-

quest came. 

 - All requests coming from unauthorized numbers are

discarded.

Authorization off - the setting is Disabled

 - If authorization is turned off, all requests are automat-

ically processed.

 - If the service center number is defined, any responses

are always sent to that number. 

 - If the service center number is NOT defined, responses

are sent to the number from which the request came

(assuming the number is known). 
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
M e s s a g e  v a l i d i t y

You can select the length of validity for telematics protocol

messages, i.e. for how long the SMS messages are stored in

the server of the operator. (The length of validity for normal

SMS messages is selected elsewhere, in the User settings).  

This setting can be used to avoid massive helping efforts in

case an emergency message has been sent a week ago and

there is reason to believe that help is no longer needed.

Click the arrow and highlight the desired option (4). 

You can choose the message validity from these: 1 hour, 6
hours, 24 hours, 1 week or Maximum time.

S M S  c e n t e r  n u m b e r

You can set the SMS center number for the telematics pro-

tocol messages. If the number is not set, the normal short

message center number is used instead. 

Key in the SMS center number (5). 

TRACE LOG SETTINGS

The device stores position data in its  memory automatically.

Stored data contains position information and time stamp. 

The maximum storage capacity is 1000 positions. Once the

log is full, the device stacks the information by dropping off

irrelevant positions. When positions cannot be dropped any

more without losing important information, there are two

ways to proceed:

•Log overwrite: In case the log is not transferred at all, the

device will automatically replace the oldest positions with

the new ones. 

•Log transfer: There are several ways to transfer the log

from the device: 

 - Locally,  by using the Benefon Configurator and data

cable, or 

 - Remotely, "over the air" by sending a specific MPTP

message separately to the device, or 

 - By using Automatic trace transfer. In this case the set-
ting is done in advance, via the Benefon Configurator,

but the actual transfer will happen automatically and

remotely, via data call.    
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
A u t o m a t i c  t r a c e  t r a n s f e r

By checking the box (6a), the trace log will be sent automat-

ically once the log is stacked full. The destination number to

which the log will be sent is the trace data call number (see

below). 

By leaving the check box blank, trace log is automatically

overwritten once it is full. In this case the log can be recalled

e.g. by sending a specific MPTP message to the device. 

T r a c e  d a t a  c a l l  n u m b e r

Key in the trace data call number (6b). This number is need-

ed for transferring log remotely from the device. The receiv-

ing unit must include a phone, modem and computer. 

When the receiving phone is a normal phone, you can store

its normal phone number for the trace data call number. 

NOTE: If the receiving phone is a mobile phone, it must con-

tain a specific SIM card, which is equipped with data feature.

Data feature usually includes a separate data call phone

number (i.e. CSD number) for data reception. In order to

get this feature, please contact your network operator.  

 T r a c e  S M S  n u m b e r

Key in the SMS number (6c). The number is needed for in-

forming the receiving party in case the data transfer fails af-

ter three attempts.  

Also make sure, the Error reports is set to Send error reports
(see below). 

ERROR REPORTS

You can set the device to inform of errors occurred in MPTP

messaging (7). An error can be, e.g. 

 - Failure in message transmission: E.g. the device is un-

able to transfer trace log 

 - Misspelling: The device detects that a command string

is uncorrect

 - Errors in logic (illegal actions): You try to turn a func-

tion on when, in fact, the function is already turned on.     

Depending on current authorization setting, the device will

send error reports to the Service center number, some other

authorized number or requesting number. For more infor-

mation, see AUTHORIZATION ON PAGE 29 and SERVICE CENTER

NUMBER ON PAGE 29. 

NOTE: If sending of Trace log fails, the device will inform of

failure only under these circumstances: 

 - Error reports data field shows  Send error reports  and 

 - Trace SMS number is stored. (see above).

POSITION PRECISION
You can set the device to show precision of the coordinate

calculation in protocol messages. Precision of coordinates

will be shown in meters until precision exceeds 254 meters.

This setting has an effect on almost all protocol messages,

which contain position information, excluding emergency

messages.  

Click the arrow and highlight the desired option (8). 
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
Authorized numbers The device is allowed to respond to protocol messages com-

ing from authorized numbers automatically, at any time. Al-

ways authorized numbers are: 

•The numbers stored as Emergency center numbers. 

•The number stored as the Service center number. 

•The numbers stored as Authorized numbers.   

To authorize individual phone numbers, key in the numbers

in the Authorized numbers data field.  

For turning the authorization on or off, see AUTHORIZATION

ON PAGE 29. 
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Emergency settings 
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
SETTING CONFIRMATION FOR EMERGENCY
MESSAGE DELIVERY

By checking the Confirm box, you can request a confirma-

tion just to make sure that someone has received an emer-

gency message. The device will resend  emergency messages

until it receives a confirmation of the successful delivery.

You can also specify the waiting time, i.e. how long a time

the phone waits for the confirmation before trying to reach

some other emergency center number. 

NOTE: The emergency confirmation feature (1) is not sup-

ported by all control systems. Using this feature in a system,

which does not support it can cause massive resending of

messages and high charges.

SOS ACTIVATION

The emergency button on the top of the device is used for

manually initiated SOS calls/messages.  

The emergency cycle can be initiated either by 

•pressing the emergency button quickly twice, or 

•pressing and holding down the emergency button for a

few seconds. 

Click the arrow (2) and highlight the desired option. 

SELECTING EMERGENCY CALL CYCLE MODE

You can define order for making emergency (voice) calls

and sending emergency messages while the emergency cycle

is on. 

Click the arrow (3) and highlight the desired option: 

•First SMS, then calls: When the emergency cycle is initi-

ated, first the device will send the emergency messages,

after which the voice calls will be made starting from the

top of the list of the emergency numbers.  

•Alternately: The device will make a voice call and send an

SMS in pairs according to the list order, starting from the

top.  

SETTING EMERGENCY CALL CONNECTION
WAITING TIME  

You can define for how long a time the device tries to call a

single emergency number before moving on to the next

number in the list of emergency numbers. 

Click the arrow (4) and highlight the desired option.  
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
EMERGENCY CENTER NUMBERS

The emergency (SOS) messages are sent and emergency

calls are made to the numbers stored in the emergency cen-

ter list (5). 

The numbers are in priority order, starting from the top of

the list. These numbers work as "a chain": 

You can have two numbers (a phone number and an SMS)

associated with each emergency center number. 

Check the box to make sure, the corresponding number is

used during an emergency cycle. 

For more information on how the emergency cycle works,

see the EMERGENCY CYCLE ON PAGE 49.
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Notifications
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
POOR SATELLITE COVERAGE 

Notify service center when satellite coverage drops (1):
The device can be configured to notify the service center if

the satellites are suddenly dropped and position is lost, e.g.

when entering in a building. 

Key in the number in minutes. 

The timeout indicates, for how long the device is allowed to

stay in poor satellite coverage before sending a protocol

message to the service center - the smaller the number you

set in here, the faster the device will react to lost satellites

and the sooner the notification will be sent. 

NOTIFY SERVICE CENTER OF BATTERY 
STATUS 

By checking the box (2), the service center will be notified

of some events occurred in battery status. 

Notifying means sending a protocol message to the service

center, for example in these cases: Low battery, temperature

too warm/too cold for charging or using battery, battery fail-

ure. 

 

SETTINGS FOR MANUAL POWER ON AND OFF

You can set some restrictions for switching the power of the

device on or off manually(3). You have three alternatives to

choose from: 

•No restrictions: The phone can be turned on and off as
usual. The service center will NOT be notified of the

power on/off. 

•Notify service center: The service center will always be
notified when the phone is powered on or off. Notifying

means sending a protocol message to the service center. 

•No power-off : The phone cannot be powered off normally

(by pressing /). Moreover, if the phone  powers off for

some reason (e.g. Low battery), the phone will send a

protocol message to the service center.  
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
WAYPOINT TRACKING  

Waypoint tracking is remotely controlled by the service cen-

ter. When the waypoint tracking is turned on, the alarm

(incl. position information) will be sent to the service center

when the device is moving out or in to the pre-defined area.

The device can also be configured to send the position in-

formation to the service center whenever crossing the bor-

derline - despite of the moving direction. 

NOTE: When entering into the pre-defined area, the alarm

will be sent when crossing radius. When entering out of the

pre-defined area, the alarm will be sent when crossing radi-

us plus perimeter of 100 meters. 

•Name (1): You may key in the desired name for a waypoint

. You can define up to 30 separate, circular areas: The

areas are separated from each other by an ID number and

a  name.  

•Center point coordinates (2): The waypoint area is defined
by keying in Latitude and Longitude and a Radius of an

area in meters. The radius should be rounded to tens,

otherwise the software does the rounding. E.g. by enter-

ing 67, the actual radius will be rounded  to 70 meters. 50

meters is the minimum value. 

•Alarm (3): After activating a waypoint, you can select an
alarm option for this waypoint. You have three choices:

Alarm will be turned on when arriving to a waypoint,

departing from a waypoint, or whenever crossing the bor-

derline (both directions). Each waypoint can have alarm

option of its own. 

•Activation of a waypoint (4): To activate a waypoint, check
the Active box (on the same row), to deactivate the way-

point, leave the check box blank. 

NOTE: The waypoint tracking does not contain automatic

switch off or duration options. The feature must be sepa-

rately deactivated when it is no longer needed.  

RESETTING THE COORDINATES 

To reset the coordinate values, click the latitude and longi-

tude data fields  (the ones, you want to reset). 

MARKING ALL WAYPOINTS FOR ACTIVATION/
DEACTIVATION AT ONCE 

Click the Active box on the top row (5). 

Note that activation/deactivation will actually take place

only after you have transferred the information to the de-

vice. 

1 2 345
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
SENSOR SETTINGS: VERTICAL SENSOR

Sensor is an additional feature. The feature is activat-

ed by an activation key supplied to you by the man-

ufacturer. For more information, see ACTIVATING NEW

FEATURES ON PAGE 13. 

NOTE: The device must also have specific battery

which includes the sensor component. For more in-

formation, see ORDER CODES ON PAGE 57. 

The sensor unit transmits signal indicating its status.

The status can be, e.g. orientation of the device: 

Vertical or horizontal. 

Signalling of the sensor unit can cause the device to

make an emergency cycle, i.e. send emergency mes-

sages and make emergency calls. 

Sensor status is not monitored while the device is

connected to a charger.  

Sensor can also be configured by MPTP over the air.         
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
Specifying sensor usage
You can specify sensor usage (1). By checking the corre-

sponding box, the sensor is turned on or off.

Polling interval
The device polls the signal sent by the sensor from time to

time. You can select, at which interval the polling is done,

i.e. how often the status of the sensor is checked. 

Set the polling interval (2) in seconds.    

No-alarm duration
You can specify the time, for how long the device is allowed

to be in wrong position (e.g. horizontally, if using the Verti-

cal sensor) before any actions are taken. 

Set the no-alarm duration (3) in seconds. 

If the device´s orientation is not corrected during this No-
alarm duration time period, the device makes emergency cy-

cle. After the emergency cycle ends, the device is able to re-

ceive phone calls.  

 

Alert trigger 
You can select alert trigger for the sensor (4). Click the ar-

row and highlight the desired option.  

E.g. by selecting Alerts when horizontal, you determine that

the sensor´s normal orientation is vertical, and being hori-

zontally orientated causes sensor to alert.  

The device is assumed to be incorrectly orientated once the

rotation angle exceeds 45°.  

Missing sensor
If the special battery including the sensor unit is replaced by

a normal battery, the device becomes unable to detect the

presence of a sensor. In this case, the device will proceed as

follows: 

1. The device will send an MPTP message to the service

center. The message sent is a status message with status

code 112, containing the device´s last known position.

For more information on this, see the separate MPTP

document. 

2. The device will repeat the procedure each time it is pow-

ered up. 

 
NOTE: 
THIS MODEL DOES NOT OFFER ANY KIND OF AUDIOVISUAL WARNING SIG-
NALS TO INDICATE THAT AN EMERGENCY CYCLE IS ABOUT TO START.
MOREOVER, THE ONGOING EMERGENCY CYCLE CAN BE NOTICED AS THE
GSM LED STARTS TO FLASH, BUT THERE IS NO WAY TO CANCEL OR IN-
TERRUPT THE ONGOING EMERGENCY CYCLE.
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PART B: CONFIGURING SETTINGS FOR THE TRACKKEEPER
ENCRYPTING MESSAGES
SMS and MPTP messages can be protected from outsiders by

encrypting message contents. Encryption is an additional

feature. The feature is activated by an activation key sup-

plied to you by the manufacturer. 

The whole procedure: 

First activate the feature, next generate the keys, then select

the encryption options and finally save everything in the de-

vice.

NOTE: The device must be connected to the Benefon Con-

figurator software all the time during the procedure.  

Activating encryption 
To activate the feature, do as follows:    

1. Connect the device with the software.

2. Open Save activation key from the Mobile menu. 

3. Key in the activation key and click Save in mobile.  

Generating keys
You need two different keys for encryption. 

•Message encryption key: The "long key" is needed for
encrypting message contents.    

•Distribution key: The distribution key is needed for
encrypting the new message encryption key (while it is

sent over the air). I.e. the distribution key secures the

new message encryption key during OTA transfer.

NOTE: If you generate the new message encryption key and

transfer it locally, via the data cable, the distribution key is

not needed.  

To generate the keys, do as follows: 

1. Open Encrypting>Encrypting keys from the Edit menu.  

2. Check the boxes and click Generate.

3. When generating the keys, the new keys will be created

into the files. Select the destination directory, name the

file and click Save. Name the other key file and click

Save once again. 

4. Click Close. 
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Selecting encryption options
1. Open Encrypting>Encrypting keys from the Edit menu.  

2. Select the desired options by checking the correspond-

ing boxes. See below:

Encrypting based on message type 

 - SMS and MPTP messages are NOT encrypted.

 - Only MPTP messages are encrypted. 

 - Only SMS messages are encrypted. 

 - Both SMS and MPTP messages are encrypted. 

Encrypting based on destination 

 - Messages to service center and authorized numbers are

NOT encrypted. 

 - Messages to service center are encrypted.

 - Messages to authorized numbers are encrypted. 

 - Messages to service center and authorized numbers are

encrypted. 

3. Check the boxes in the Save key in mobile phone. 

4. Finally save all the options and the keys by clicking the

Save in mobile phone box in the bottom left. Browse the

directory, find the key file and click Open (do it  twice to
save both keys).    

CODE SETTINGS

Automatic PIN entry
The PIN code can be pre-programmed to the EEPROM of the

device. It cannot be read by any means from the device. In

startup the PIN code is entered automatically by the device

software. 

The PIN code can be changed in the Benefon Configurator

by choosing Change PIN code from the Mobile menu. Key in

the new code and confirm it.

The option is available only when the device is connected to

the software. 

Security code 
The security code secures telematic settings. If the setting is

enabled, the code is requested each time when powering up

the system (software in connection with the device).  

The security code settings are located in the Mobile menu. 

 - To enable the code, check the box, to disable the

code, leave the check box blank. 

 - To change the code, first click the corresponding box.

Key in the old code, key in the new code and confirm it. 
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PART C: OPERATING THE 
TRACKKEEPER

USER INTERFACE 

Indicator LEDs 

ALL THE LEDS ARE LIT IN UNION 

LEDS
•GSM (red)
•GPS (yellow)
•Battery (green)

KEYS
•Power  on/off
•Increase volume
•Decrease volume

BENEGUARD BUTTON
For sending emergency 
messages

Battery

Battery release 
catch

System 
connectorMicrophone

Plug for external 
GPS antenna

GPS antenna

Symbol Meaning

� On for 1 second

� Off for 1 second

� On for half a second

� Off for half a second

... Starts over from the beginning of the pattern

All the LEDs are lit in 
union and show 

Status/Action 

 

����������
�
(once) 

Answers an  incoming call.
- NOTE: In order to work, a valid SIM  
card must be inserted, and the device 
must be turned on, and the auto 
answer must be turned on. 

����������
�����
(once)  

An MPTP message is received and 
accepted. 
- NOTE: In order  to work, a valid SIM 
card must be inserted, and the device 
must be turned on. 

��...  Incorrect PIN. It causes the device to 
power-down. 
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BATTERY   GPS RECEIVER 

GSM RECEIVER

Battery LED (green) 
shows 

Battery status

�... (constantly on) 4/4 (battery is full)

� � � �����... 
(6 sec. sequence)

3/4

� � �������... 
(6 sec. sequence)

2/4

� ���������...
(6 sec. sequence)

1/4

���������...  
(5 sec. sequence)
- NOTE: The pattern cannot 
be seen, if the LEDs are lit 
for some other reason at the 
time of this event, or if less 
than 5 minutes has  passed 
since the event was last 
invoked. 

0/4 (battery is low)

��... (2 sec. sequence) Charging. The LED flashes current 
battery status in turns with charging. 

GPS LED (yellow) shows GPS status

�... (constantly on) Valid fix

���... (2 sec. sequence) Sleeping (zzz)

��... (2 sec. sequence) Searching/Locking

�... (constantly off) Off

� (lit for 3 sec.)
- NOTE: The LED pattern cannot 
be seen, if the LEDs are already lit 
for some other reason at the time 
of this event. 

A valid position fix is finally 
acquired after searching for a 
while. 

GSM LED (red) shows GSM status

�... (constantly on) Network available

�... (constantly off) Off

��...  (2 sec. sequence) Searching

���������... 
(6 sec. sequence)

No network

�... 
(flashes in every 5 seconds, if the 
LED is not already lit for some 
other reason)

Power is on

� ����������... Active call

���...  (2 sec. sequence) Invalid SIM
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Keys 
Key Function Procedure

/ 
(press and hold 
down for a few 
secs) 

Power-up The device is turned on. All the LEDs are 
lit. The device sends a message via the 
system connector to inform the possibly 
attached external device of the power-
up. An automatic PIN entry and a 
removal of all short messages found on 
SIM will  take place.  - NOTE: For the 
automatic PIN entry, the PIN code must 
be programmed  in the device. 

/ (press and 
hold down)

Power-
down

The device is turned off. 
All the LEDs are lit. 

/ 

(press briefly)

Indicator 
refresh

Idle mode is entered. All the LEDs will 
start to show their current status. 

Ö 

(press and hold 
down for a few 
seconds)

BeneGuard-
emergency 
call

The device is turned on. The GPS is 
turned on. The BeneGuard emergency 
cycle is started. 
- NOTE: In order to work, certain settings 
and phone numbers must be configured 
in the device, such as emergency center 
numbers  and emergency confirmation 
setting. 

z y 

(press the side 
keys briefly)

Volume 
adjust

Adjusting  volume within the 5-step 
scale. The upper key increases the vol-
ume while the lower key decreases the 
volume. NOTE: - The keys work only 
when the call is connected and Headset 
attached to the device.  
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INCOMING CALLS AND MESSAGES
For incoming calls and messages 

•a valid SIM card must be inserted and  

•the device must be turned on.

Incoming calls
The Auto answer must be turned on, otherwise an incoming

call is dropped at once. For more information, see AUTOMAT-

IC ANSWER ON PAGE 18. 

Another way to receive an incoming call: The caller´s num-

ber must be stored in the list of allowed callers, and the auto

answer box (associating the number) must be checked. For

more information, see LIST OF ALLOWED CALLERS ON PAGE 29. 

Incoming short messages
An incoming short message is echoed to the system connec-

tor, so that an external device can check it. Reading, writing,

sending and receiving normal short messages via the device

is possible only in case the device is connected to an exter-

nal device, such as a computer. For more information, see

SIM FEATURES: SHORT MESSAGES ON PAGE 14. 

No messages are ever stored on SIM card. Even the MPTP

messages are cleared once they are processed.    

Incoming MPTP messages
An incoming short message is processed only if it is a known

MPTP message. However, if the Authorization setting is en-
abled, only messages from authorized numbers are pro-

cessed, others are discarded at once. Numbers stored as

Service center and Emergency center numbers are always au-

thorized and processed. For more information on authoriza-

tion, see AUTHORIZATION ON PAGE 29. 

REMOTE CONFIGURATION MESSAGE
The device may receive a specific MPTP message for the re-

mote configuration/activation. Remote configuration/activa-

tion messages contain settings and values for e.g.

Emergency numbers, Authorized numbers, AGPS-parame-

ters, Activity timer and GPS operating mode. 

For more information on remote configuration, see the doc-

ument on MPTP commands, located at the Web site:

www.benefon.com. 

LOCATION REQUEST MESSAGE 
The device may receive several different messages request-

ing location.  Such messages can be, e.g. Location request

messages (?LOC), or Location history request messages

(?HIS). For more information on how the device responds

these messages, see DEFAULT BEHAVIOUR FOR LOCATION RE-

QUEST ON PAGE 27. 

For more information on how to create location request

messages, see the document on MPTP commands, located at

the Web site: www.benefon.com. 
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AT commands
The device may receive an AT command via the system con-

nector. The AT commands can be used for carrying out sim-

ilar things that are done via MPTP messages. 

For example, AT commands are used when configuring set-

tings to the device locally, by using the Benefon Configura-

tor software.   

For more information on handling AT commands, please see

the separate document on AT commands, located at the Web

site www.benefon.com.  

OUTGOING MESSAGES
Depending on the configuration, the device may send some

MPTP messages to the service center or some other autho-

rized number. Such messages can be, e.g. 

•Power on/off, charging or battery status notifications

•Lost satellite coverage notifications 

•Position updates (e.g. Area tracking or Waypoint tracking)

•Several types of calculated positions sent in sequence

(e.g. when using Tracking or Activity timer)

•Individual position information sent as a response to an

MPTP request (e.g. Location request, Location history

request). For more information, see DEFAULT BEHAVIOUR

FOR LOCATION REQUEST ON PAGE 27. 

•Alert messages (e.g. when using Vertical sensor or Emer-
gency cycle)  

•Collected position history to unravel previously travelled

route (e.g. when using Trace log)

For more information on MPTP messages, please see the

separate document on MPTP commands, located at the Web

site: www.benefon.com. 
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Power notifications

POWER ON/OFF MESSAGES

Turning the power of the device on or off can be restricted.

If the device detects that a power restriction is set on and vi-

olated, it will notify the service center of the incident, i.e.

send an MPTP message to the service center. 

For more information, see SETTINGS FOR MANUAL POWER ON

AND OFF ON PAGE 37. 

BATTERY STATUS MESSAGES

The device can be configured to inform the service center of

various incidents on its battery status. When the device de-

tects that, e.g. the battery is low, or the temperature is too

cold or warm for using the battery, the device will inform

the service center by sending an MPTP message to the ser-

vice center. 

The message will be sent only in case the event takes place

for the first time after powering on or being disconnected

from the charger. 

For more information, see NOTIFY SERVICE CENTER OF BAT-

TERY STATUS ON PAGE 37. 

CHARGER CONNECTION MESSAGES

The device can be configured to inform the service center of

changes in charger connection. When the device detects that

it is being connected to or disconnected from the charger,

the device will inform the service center by sending an MPTP

message to the service center.  

For more information, see SETTINGS DURING BATTERY LOADING

ON PAGE 20. 

Resending MPTP messages 
The device has MPTP message storage: If sending of an MPTP

message fails e.g. in case there is no service at the moment,

the device will send the message later, assuming the MPTP

protocol message storage has space left to deposit the mes-

sage. The storage capacity is 100 messages. After the device

is in service again, these messages are automatically sent for-

ward. 

Message type: As a default value, the message type is set to

Text messages. 
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Emergency cycle
Emergency cycle means making specific emergency call to

pre-configured numbers. Depending on configuration, the

emergency call can contain both (voice) calls and messages.

If an external audio (a combination of microphone and

speaker) is connected, a voice call is possible. Calls can be

made to mobile phone numbers, or normal phone numbers. 

Messages are protocol messages sent to mobile phones via

SMS. The emergency message contains both GPS coordi-

nates and GSM network measurement report.

The emergency numbers are in priority order, starting from

the top of the list. These numbers work automatically, 

as "a chain", through the list. If the first number is unreach-

able (after two attempts), the device calls or sends the re-

port to the second number. If it is not answered either, the

device will go on to the third number on the list and so on.

The device tries to reach contact with the other numbers

once before moving on to the next number on the list. If

there is still no answer after going through the whole list,

the calling procedure will be started all over. 

BeneGuard emergency call/message is initiated by pressing

the integrated BeneGuard button (Ö) on the top of

the device. The button must be pressed the way it has been

configured: A long press or two quick presses. For more in-

formation, see SOS ACTIVATION ON PAGE 34. 

The emergency cycle is over when the calls are made and

messages are sent, and the device returns to normal opera-

tion.

 

CHECK LIST
•SIM card must be inserted in the device. 
•Emergency settings (such as Emergency center numbers, 
Sos activation) must be configured and transferred in the 
device in advance. For more information, see EMERGENCY 
SETTINGS ON PAGE 33.

•There must be adequately charge left in the battery. If the 
battery runs down quite easily, it might be wise to provide the 
device with the power battery and possibly turn off the set-
tings which increase power consumption considerably. The 
device can be configured to inform of battery status, as well. 

CIRCUMSTANCES WHICH MAY AFFECT ON EMERGENCY CYCLE
•Busy telephone line - applies to a voice call connection. 
•Message transmission error caused by the carrier of an SMS, 
i.e. the network operator.

•Being in a shadow area of the GSM network at the time of the 
event.  

•Poor GPS coverage during emergency cycle may cause  the 
emergency cycle completion to slow down.      

NOTE: If the device is permanently installed in a location where
frequently occurs poor satellite coverage or weak network sig-
nal, external GPS and/or GSM antennas must be installed with
the device.  
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MAKING AN EMERGENCY CALL WHICH
INCLUDES BOTH CALL NUMBERS AND SMS 

NUMBERS  

1. Press the BeneGuard button (<) according to config-

uration: A long press/two quick presses.   

2. The device sends the message including position infor-

mation. If current position coordinates are not available,

previous coordinates will be sent instead.  

3. If the Emergency confirmation setting is turned on, the
device will go on sending the message until receiving

party sends confirmation to the device.     

4. Microphone opens one-way audio: It is possible to listen

in the device and its surroundings. Headset (an accesso-

ry) enables audio both ways. 

5. The device alerts until the call is answered.

6. A voice call in progress. 

Sensor alerts
To let the emergency cycle take place: Do nothing. 

To cancel sensor alert and prevent emergency cycle from

starting, lift the device up to vertical position. Do it before

the No-alarm duration expires. 

NOTE: There is no way to cancel or interrupt the emergency

cycle once it has already started.   

In case the device cannot detect the sensor, it will inform

the service center that the sensor is missing.   

POSITIONING FEATURES

Responding location request 
messages 

The device may receive several different messages request-

ing location.  Such messages can be, e.g. Location request

messages (?LOC), or Location history request messages

(?HIS). For more information on how the device responds

these messages, see DEFAULT BEHAVIOUR FOR LOCATION RE-

QUEST ON PAGE 27. 

For more information on how to create location request

messages, please see the separate document on MPTP com-

mands, located at the Web site: www.benefon.com. 

Device also checks if an AGPS can be retrieved and requests

it automatically to speed up calculation. Using the AGPS re-

quires that the parameters for the AGPS are configured in

the device. For more information on AGPS settings, see AS-

SISTED GPS (AGPS) ON PAGE 22.
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Network positioning support
The device can be requested to send its current GSM net-

work parameters at any time. Requesting number can be e.g.

service center. The message that the device sends as a re-

sponse is called the Network Measurement Report (NMR). 

The device will send network parameters to the requesting

number automatically in two cases: 

 - Authorization is enabled and the requesting number is

authorized.

 - Authorization is entirely disabled and the service center

number is NOT configured in the device. 

Emergency and service center numbers, and numbers

stored as Authorized numbers are always authorized.

If the authorization is enabled and the position request

comes from an unauthorized number, the  device will dis-

card the request. 

If the service center number is defined and authorization is

disabled, the response is always sent to the service center

number.

The Network Measurement Report contains rough data and

the position needs to be separately calculated by taking into

account surrounding base stations and distances in between

them. Calculation of the position needs a separate server,

available from Benefon Partners. The device cannot calcu-

late the position based on network parameters by itself. 

Activity timer procedure
1. The activity timer is activated as soon as the time set in

the Start time data field matches with the current time. 

2. The device will be turned on. This automatic power-up

does not cause the LEDs to be lit. 

3. The position is calculated and sent to the service center

according to configuration. For more on configuring ac-

tivity timer, see ACTIVITY TIMER ON PAGE 17.

4. The device will then remain in idle mode for the pre-de-

fined time after which it will be turned off. 

However, the power-down can be postponed by sending a

Location Request message (?LOC) to the device. Postponing

might be necessary for completing all ongoing events before

the power is turned off. 

All tracking messages, including ?LOC messages override the

Interval time set in the Activity timer.  
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Transferring trace log  

LOCAL TRANSFER 

When the device returns home, it is connected to the Bene-

fon Configurator by data cable. The log will be loaded from

the device to the software the same way as other settings.

For more information, see CONNECTING THE TRACKKEEPER TO

THE BENEFON CONFIGURATOR ON PAGE 10 and LOADING SET-

TINGS FROM THE TRACKKEEPER TO THE SOFTWARE ON PAGE 11. 

When the Benefon Configurator loads the log directly from

the device, the trace log file appears automatically in the dis-

play in readable text format.

The Trace log icon is shown under My Benefon node on the
left, and by clicking the icon the actual trace log file will be

shown in the Document window on the right. 

REMOTE TRANSFER

The device sends the log to the service center remotely, as a

trace data call, using Z-modem protocol. 

Normal speed for data transfer in the GSM-network is 9600

baud. Since the Benefon products support higher speed, the

transfer can be sped up to 14400 baud, in case the higher

speed is supported by the network and SIM card, as well.

Speed configuration can be done by specific MPTP message.     

The computer must contain a modem application which

supports Z-modem protocol (e.g. Windows Hyperterminal).

NOTE: Check the modem settings. Serial port must be cor-

rect, and transfer speed must be set according to receiving

phone. E.g. when using the Benefon mobile phone as the re-

ceiving phone, transfer speed must be set to 19200 bits/sec-

ond. 

During the transfer, the receiving mobile phone must be

connected to the computer by a data cable. 

In order to make the modem answer automatically incoming

data calls, key in the command ats0=1 and press Enter on

the keyboard. The command is associated with the receiving

mobile phone. The automatic answer for data calls can be

turned off by keying in the command ats0=0. 

NOTE: Automatic answer setting of the receiving mobile

phone is for voice calls, not data calls and thus it must be

turned off. 

The incoming log file will be found in your computer. De-

fault destination directory depends on modem settings and

can be changed. In most cases the log file can be located at

the root directory of the modem application. 

The binary-coded log file name contains U (or some other)

letter and the phone´s serial number. The log file identifier

is .bin. 
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Sample case by using Windows Hyperterminal  

STEP1: CONFIGURING MODEM APPLICATION 
FOR DATA RECEPTION

1. Connect the receiving mobile phone to the computer by data cab-
le and open the Windows Hyperterminal modem application.

2. Open New connection (from the File menu if the dialog box is not
displayed). 

3. Name the connection -> Ok. 

4. Select port for the connection (e.g. COM1) -> Ok. 

5. Set transfer speed to 19200 Bits/Second ->Ok. 

6. Open Receive file.. from the Transfer menu. 

7. Click Browse and find the desired destination directory ->Ok. 

8. Select Z-modem for Receiving protocol ->Receive. 

When the modem configuration is done, you may save the file by
clicking Save as... from the File menu.  

Close the connection by clicking Disconnect  from the Call menu. 

From now on, whenever you need this connection, you can use the
profile just created by selecting Open...  from the File menu.    

STEP2: RECEIVING REMOTELY SENT LOG FILE 
Connect the receiving phone to the computer by data cable/BWcable
and open the Windows Hyperterminal modem application.

To ensure the connection between mobile phone and the modem, you
may key in ATI on the screen and press Enter -> the modem will iden-
tify receiving mobile phone. 

Key in ats0=1 and press Enter -> the mobile phone will answer auto-
matically incoming CSD calls. 

When the mobile phone starts alerting, the modem will display RING.
When the mobile phone answers, the data transfer dialog box appears
on the screen. When the transfer is finished, the dialog box disap-
pears and the connection can be switched off. 

If you do not use the automatic answer, do as follows (when the phone
starts alerting): Press the Hook-up key on the phone keypad OR key
in ATA on the screen and press Enter. 
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OPENING AND PROCESSING REMOTELY SENT 
LOG FILE (IN THE BENEFON CONFIGURATOR) 

Start the Benefon Configurator and open the trace log file as

follows: 

1. Highlight the Trace log icon shown on the left side of the
screen, under My computer node. 

2. Choose Open from the File menu (or, click the mouse´s

right button and highlight Open). 

3. Click the Files of type setting and highlight All Benefon
Configurator files. 

4. Browse the directories and files until the destination di-

rectory and file is found. The file identifier is .bin.  Click

Open. 

Trace log file is originally in binary-coded format. When the

file is opened in Benefon Configurator, the software gener-

ates the file and displays it as a table in a readable text for-

mat. 

If you want open and process these .bin files in some  cus-

tomized application (other than Benefon Configurator),

please contact your Benefon Partner for detailed directions. 

S a v i n g  t h e  l o g  f i l e

To save the trace log in Benefon Configurator, choose Save
or Save as.. from the File menu. The trace log file will be

saved in readable text format (.log). 

D e l e t i n g  t h e  l o g  f i l e

To delete the trace log in Benefon Configurator, choose De-
lete trace log from Mobile menu. 

NOTE: If you delete trace log from My Benefon node, the log
is lost once and for all. So, make sure the log is stored in

some place else in case you need to recall the log informa-

tion afterwards.      

PROCESSING TRACE LOG BY USING SOME
OTHER APPLICATION

Trace log files cannot be edited in Benefon Configurator. In

order to modify or print the log file, do as follows: 

1. First save the log in Benefon Configurator. The log file

identifier will become .log. 

2. Open Windows Excel or Notepad. Make sure, the Files

of type shows All files.  

3. Open the log file in the chosen application.  
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PART D: POWER MANAGEMENT 

POWER SUPPLY
•Mains charger CMA-70-230 (with the standard charger

cable FMC70, or robust charger cable FMC79)

•Cigarrette lighter charger CCS-71-12

•Standard Li-Ion batteries 

 - 650 mAh (BBL77S)

 - 900 mAh (BBL77N)

 - 1200 mAh (BBL77P)

 - 1700 mAh (BBL77G). 

•Special Li-Ion battery 1200 mAh, including Vertical sensor

component (BBL79P). 

 - Note that this special battery only works under these

conditions: The NT 2.0 software is installed and the

Vertical sensor feature is activated in the device.     

The battery type may vary depending on the market area and

sales package. In unclear cases, check the battery compati-

bility with the dealer. 

MAINS CHARGER 
The mains charger should only be used indoors. Make sure

that the voltage in the country which you are staying corre-

sponds to the voltage (230 V) of the charger.

When charging, connect the charger (round) end of the ca-

ble into the charger base and lock it by turning it half a turn

clockwise. Plug the cable´s square end/flat end (with the ar-

row/button facing up) into the system connector on the de-

vice. 

Plug the charger into a mains outlet. Charging will start au-

tomatically.

The mains charger is provided with the device, but is also

available from the assortment of Benefon accessories. For

more information on other charger types, see PART E: ACCES-

SORIES ON PAGE 57.
POWER SUPPLY 55



PART D: POWER MANAGEMENT
CHARGING
The battery must be fully charged before taken into use. The

battery will reach its full capacity only after two or three

charging times.  

The device controls the charging status, the battery temper-

ature and power supply during the charging operation. You

can find out the status of the battery by monitoring the indi-

cating battery LED. 

The ideal temperature range for charging is +10°...+30°C. If

charging the battery above or below these temperatures, life

of a battery may be shortened. Also, the battery may not

reach full capacity.

Never charge the battery at temperatures below 0°C.

Charging time depends on what kind of a charger and bat-

tery you have in use. When charging the Li-Ion batteries with

the quick charger, about 70% of the battery capacity will be

charged quickly, but charging the remaining 30% takes rela-

tively more time. 

Also note that humidity, temperature, age of the battery and

currently used features (e.g. the GPS) affect the time spent

on charging.  

BATTERY CARE AND MAINTENANCE
The continuous operating time is less when using an old

battery than when using a new battery.

When storing batteries for a long time, it is recommended

that the batteries are kept cool and fully charged in a dry

place.

Proper care and storage guarantee best possible battery ca-

pacity and maximum battery life. 

DISPOSAL OF A BATTERY
Li-Ion batteries do not contain heavy metals which can dam-

age the environment. Li-Ion batteries should be disposed of

according to the country-specific regulations.
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PART E: ACCESSORIES 
You will find complete and updated list of accessories in the

web site: www.benefon.com.

ORDER CODES

BATTERIES

CHARGERS

CABLES FOR DATA TRANSFER

EXTERNAL ANTENNAS

OTHER ACCESSORIES

Code Part

ZE2400 Standard Li-Ion battery, 650 mAh

ZE2402 Standard Li-Ion battery, 900 mAh

ZE2401 Standard Li-Ion battery, 1200 mAh 

ZE2403 Standard Li-Ion battery, 1700 mAh

ZE2415 Vertical sensor Li-Ion battery, 1200 mAh

Code Part

ZE1106 Mains charger CMA-70-230, Std cable (EUR model)

ZE1109 Mains charger CMB-70-230, Std cable (UK model)

ZE1110 Mains charger CMD-70-230, Std cable (US model) 

ZE1111 Mains charger CMC-70-230, Std cable  (AU model)

ZE1112 Mains charger CMA-70-230, Robust cable  (EUR model) 

ZE1113 Mains charger CMB-70-230, Robust cable (UK model)

ZE1114 Mains charger CMD-70-230, Robust cable (US model)

ZE3510 Cigarrette lighter charger CCS-71-12

Code Part

ZE2306 Data cable APC70

ZE2406 Data/NMEA cable APC77

Code Part

ZE2408 External GPS antenna, Radiall

ZE3232 External GSM antenna, Cottage mount

ZE2102 Cross-country GSM antenna

Code Part

ZE5520 Headset 

ZE3117 Light holder

ZE5314 Carrying case (trendline) 

YC2608 GSM antenna adapter (for connecting cottage antenna)

ABOUT GSM ANTENNA ADAPTER
A GSM antenna adapter is needed for connecting an external GSM
antenna to the device. An external GSM antenna is needed if the de-
vice is installed or used in such a location or area where frequently
exists  poor GSM coverage. 

The adapter is a standard cable containing two separate connectors: 

•SMA for the device.  
•FME for the external antenna. 
Device´s own antenna must be disconnected when attaching the GSM
antenna adapter. 
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PART F: IMPORTANT SAFETY 
INFORMATION

CARE AND MAINTENANCE
NOTE: The instructions below apply to the device, its acces-

sories, batteries in use as well as batteries taken out of use. 

•Dust and dirt may damage the moving parts of the device.

Do not use or keep the device in dusty or dirty surround-

ings. 

•Do not open the device or battery by yourself or pierce

holes in it.

•Rough handling may break the circuitry inside the device.

Do not drop, knock, twist or shake the device or its bat-

tery.

•Keep the device dry. Liquids contain minerals which could

corrode electronic circuits. If the device gets wet, turn it

off  and dry the device and the battery immediately. Put

the device into an upright position and let it dry. It is rec-

ommended that a dealer or service personnel check that

the device functions properly.

•Even though the device is splashproof, do not wet the

device unnecessarily or immerse it in water. 

•Protect the device from heat. High temperatures may

shorten the life of the electronical devices, melt or warp

plastics and damage batteries. Do not warm up the device

or battery or use it near fire. 

•Do not short-circuit the battery. Exposing the metal strips

of the battery to a close contact with a metallic object,

such as a coin, a clip or a set of keys can cause accidental

short-circuiting and damage the battery.

•Charge and recharge the battery only with the charger

specified in the manual. Use the battery only for the pur-

pose it is intended.

•Clean the device with a soft cloth, dampened slightly with

mild soapy water. Do not clean the device with harsh

chemicals, solvents or other corrosive substances. 

•Only allow service personnel authorised by the dealer to

service the device. 
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SAFETY AND PRECAUTIONS

Telematics protocol
MPTP (Mobile Phone Telematic Protocol) allows, among

other things, tracking of the device over the SMS communi-

cation. 

Automatically sent telematics messages are only allowed to

authorised numbers configured in the device. Such num-

bers can be, e.g. emergency and service center numbers. 

Position of the device is retrieved by the GPS, or by the net-

work parameters - the latter is a network-dependent service. 

The carrier for telematics messages is an SMS-message. De-

liveries of all messages is fully handled by and in the respon-

sibility of the GSM network operator and services can vary

substantially. 

The charge of a protocol message is determined  on the con-

tract by the service provider. 

GPS 
The Global Positioning System (GPS) is operated by the gov-

ernment of the United States, which is solely responsible for

its accuracy and maintenance. The system is subject to

changes that could affect the accuracy and performance of

all GPS equipment. 

Emergency calls
The device is an aid and should never be relied upon as an

only emergency device. Its  functionality is dependent on

GSM network and GPS satellites which may not be available

all the time. 

To make emergency calls, the device must be turned on and

located in an area with adequate GSM network signal

strength. Making BeneGuard emergency call also requires

GPS satellite coverage and a valid SIM-card. 

Emergency calls may not be possible on all GSM phone net-

works or when certain network services or phone features

are in use. In unclear cases, consult your network operator.      
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General
•Traffic: Strictly adhere to all eventual European and

national legislation and also honour other eventual safety

recommendations when using the device while driving a

vehicle. Place the device in its holder, do not leave it on

the passenger seat or some other place where it can break

loose in a collision or a sudden stop. When receiving a

call in an awkward driving situation, you must always put

safety before other priorities and courtesy. If you feel

uncomfortable about using a device while driving, you

should not use it. 

•Vehicles with air bags: An air bag inflates with great

force. Do not place objects, including either installed or

portable wireless devices, in the area over the air bag or in

the air bag deployment area. 

•External alert: The use of the alert device to operate a

vehicle´s lights or horn on public roads is not permitted.  

•Children: Keep the device and its accessories away from

small children to avoid causing injury to themselves or

others. Damage to the device or its accessories is also thus

avoided.

•Power supply: This equipment is intended for use with

the specified power supplies listed in the Operating

Instructions. Any other usage will invalidate any approval

given to this apparatus and may be dangerous.

•Other accessories: Any other accessories used should

also be approved by the device manufacturer. Check the

compatibility of new power supply units and other acces-

sories at the dealer. 

•Connections: All installations, connections and service

regarding the device, its power supply and accessories

should be approved by the device manufacturer. Use of

any unauthorized accessories, modifications or attach-

ments may be dangerous and voids the device warranty if

said accessories cause damage or a defect to the device.

•Magnetic fields: The device contains small magnetic

components. Even though the magnetic fields of the com-

ponents are weak, they might damage magnetic cards,

such as bank and credit cards. We recommend that you

would keep the device away from magnetic cards. 

•Storing positions: Position information is stored cor-

rectly in the device when the GPS is turned off (from the

GPS menu) or powered off (by pressing the topmost side

key). To prevent the memory from becoming corrupted,

never power off  the device by removing the battery. 
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Radio frequency (RF) energy
•Aircrafts: Turn your device off before boarding any air-

craft and do not use the device while in the air, also make

sure that the automatic timer function will not activate

the device during a flight. Besides being illegal, the use of

a device in an aircraft may endanger the operation of the

aircraft or disrupt the mobile network. Failure to comply

with this instruction may lead to suspension or denial of

mobile phone services, and possibly even legal action.

•Hospitals: Turn your device off before entering hospitals

or other health care facilities where medical electronic

equipment may be in use. Such devices can be extremely

sensitive to radio frequency interference. Only use the

device with permission and under the instruction of hos-

pital staff.

•Medical devices: Remember that any personal medical

devices (such as hearing aids or pacemakers) may be

affected by RF energy if they are not adequately shielded.

Consult the manufacturer or vendor of the equipment to

determine the proper shielding.

•Posted facilities and country-specific regulations:

Power down the device in any facility where posted

notices so require. Also follow all the country-specific reg-

ulations applicable to where the device is used. 

•Potentially explosive atmospheres: Turn off the device

at refuelling points, e.g. gas stations. Also observe restric-

tions on the use of radio equipment in fuel depots, chem-

ical plants or where blasting operations are in progress

because remote control RF devices are often used to set

off explosives. Do not store or carry flammable liquids,

gases or explosive materials in the same compartment as

the device, its parts or accessories. 

•Other electronical equipment: Using the device may

cause interference with a vehicle's electronic equipment if

it is not adequately shielded. Consult the manufacturer or

the vehicle seller to determine the proper shielding.

•Computers: Remember that using the device close to a

computer may cause interference. When using your

device near such equipment keep a distance of about one

meter.

•Body parts: When the device is in operation do not touch

the antenna with eyes, mouth or bare skin to guarantee

proper function. 
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BENEFON WARRANTY
A warranty certificate with the date of purchase is enclosed

in the delivery. Service operations are carried out for free at

Benefon during the warranty period. 

BENEFON warrants its products to be free of defects in ma-

terial or workmanship when leaving the factory. If a defect

is found during the given warranty period, the customer

should without delay and latest within the given warranty

period return the product, together with the warranty certif-

icate and the purchase receipt, to the BENEFON dealer who

sold the product or, if this is not feasible, to any other au-

thorised BENEFON sales or service facility.

A defective product with valid BENEFON warranty will be

made good by having it repaired or replaced, as seen appro-

priate by BENEFON in each case. Repair or replacement of

the product does not extend the original  warranty period.

The warranty does not cover defects caused by using the

product with peripheral equipment or accessories not sup-

plied or approved by BENEFON, or defects caused by repairs

or modifications carried out by parties not authorised by

BENEFON. 

Neither does the warranty cover defects directly attributable

to abuse, misuse or accident of any kind nor changes in con-

sumable parts (e.g .batteries) attributable to normal wear

and tear.

The warranty is void if the manufacturing identity data at-

tached to the product have been altered, erased or rendered

unidentifiable.

BENEFON assumes strictly no responsibility for special, in-

cidental, punitive or consequential damages, or loss of use.

 

  

The warranty period of this BENEFON product expires 
in .....................................................................................

BENEFON dealer who sold the product.........................

.........................................................................................

.........................................................................................

IMEI code/serial number................................................

.........................................................................................

P.O. Box 84, FIN-24101 Salo, 

Finland, 

Fax int. +358 2 733 2633
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